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Introducing the AR745 Router

Congratulations on purchasing an AR745 Modular Branch
Office Router—A cost-effective, multi-service router platform
for larger branch office and corporate locations demanding high
data throughput, upgradeable connectivity and support for
multiple WAN services.

This guide will introduce you to the AR745 router and guide
you through the most common uses and applications. Getting
started will not take long—many applications can be set up in
just a few minutes. If you have any questions about the AR745
router, contact your local distributor or reseller.

CONNECTIVITY OPTIONS

The AR745 supports a wide range of network interfaces so
you can choose the network service that is right for you. High
speed routing is supported between the two built-in 10/100
Mbps Fast Ethernet ports. Hardware-based STAC/HiFn
compression and DES encryption maximize data throughput
without compromising routing performance.

The AR745 supports up to seven Port Interface Cards (PICs)
for flexible configuration.  LAN and WAN PICs can be simply
and quickly field-upgraded as business needs change.  PIC
connectivity options include E1/T1, Frame Relay, Primary Rate
and Basic Rate ISDN, leased circuits to 2Mbps, X.25, multiple
Ethernet and asynchronous serial for external modem dial-up.

WHAT CAN THE AR745 DO FOR YOU?

Connect You to the Internet

The AR745 router provides you with high speed, unrestricted
access to the Internet. Advanced compression techniques
together with ISDN channel bundling mean that graphic
downloads simply speed along. The intelligent bandwidth
management facility automatically opens more ISDN channels
when extra capacity is required, and closes them when traffic
levels reduce. The AR745 supports advanced features that make
it easy for your Internet Service Provider to dynamically assign
your Internet address every time you surf the net.

Connect Branch and Corporate Offices

High performance RISC-based technology ensures the high data
throughput demanded by data intensive and multimedia
applications. Powerful firewall features protect against

unauthorised access, and break-in attempts can be logged for
later analysis. If your office LAN uses private IP addresses not
registered on the Internet, the AR745 can translate these private
addresses to a single registered IP address for communication
across the Internet, saving you the time and expense of assigning
registered IP addresses to each device on your LAN.

Connect You to Other Trading Partners

The AR745 allows companies to communicate with other
trading partners using ISDN, leased line, Frame Relay or X.25
services. Information such as reports, quotes and orders can be
transferred between the two offices. The AR745 does not place
any limits on the number of network users, so it will continue
to support you as your business grows.

Connect Teleworkers and Dial-in Users

The AR745 supports up to 26 dial-in connections via external
modems using the AR040 4-PIC NSM and six AR024 PICs.
Teleworkers and mobile users can dial into an AR745 router at
their local office and access information, read email, download
files and connect to the Internet. Combine dial-in services with
AT-VPNet to provide teleworkers and mobile users with
secure access to the corporate network. External modems can
also be used to provide network connections for extra
bandwidth at peak times or to backup ISDN, Frame Relay or
leased lines.

Protect Your Network from Unauthorised Access

When you connect to the Internet you have unrestricted
access to the World-Wide Web. Likewise, it has access to you!
To ensure that only authorised users can access your local
network, the AR745 has an extensive range of security
measures, including:

• A fully featured stateful inspection firewall which dynamically
filters traffic flows based on manager-defined rules. All
firewall events are logged to the router’s Logging Facility, and
significant events generate notifications via SNMP traps,
email or triggers. The firewall automatically detects and
combats a range of denial of service attacks including SYN
and FIN flooding, Ping of death, Smurf attacks and port scans.

• IPsec-compliant security services.

• Calling Line Identification (CLI), which uses the ISDN
address of the incoming call to verify that the caller is calling
from an authentic location.
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• ISDN callback, which verifies the caller using CLI, disconnects
the incoming call, then calls the destination back to establish
the link. This allows a remote site to reverse the call charges
to a central office, for central billing of ISDN calls.

• PAP and CHAP to authenticate remote access using
passwords and user names.

• TACACS and RADIUS for authenticating users. The AR745
can query TACACS or RADIUS servers running on a
network host to authenticate users. A centralised database
simplifies management of a large user population.

Protect Your Data with Powerful DES Encryption

If you are transmitting sensitive information, such as cost
estimates, product plans, and investment opportunities across
the Internet you want to secure this data so that it is
indecipherable to all but the intended recipients. AT-VPNet
provides powerful DES or 3DES encryption. Your data is
scrambled before it is transmitted across the Internet, making
the data meaningless if intercepted. Only the data portion of
the IP packet is encrypted; the address information required for
routing the packet to its destination is unchanged. AT-VPNet
uses a separate daughter card that fits inside the AR745 to
offload the processor-intensive task of data encryption, so
routing performance is not affected.

Note: The export of strong DES-based cryptography such as AT-VPNet
is subject to export controls in most countries. Contact your distributor
or reseller for details.

THE AR745 FEATURE SET

The following are just some of the features provided by
the AR745:

• Wide-area networking via Frame Relay, Point-to-Point
Protocol, and X.25.

• Basic Rate and Primary Rate access to Integrated Services
Digital Network (ISDN) services, with dial on demand,
bandwidth on demand and channel aggregation facilities.

• Multiprotocol routing, including TCP/IP, Novell® IPX,
DECnet™, AppleTalk® and GRE (Generic Routing
Encapsulation) protocols. Supported routing protocols include
RIP and RIP v2, EGP, OSPF,  and Novell® RIP and SAP.

• Terminal server.

• Bridging.

• Backup server for leased line, PSTN and ISDN.

• LPD and Streams print server for network-wide printing.

• Advanced packet filtering for IP, Novell® IPX and DECnet™.

• Frame Relay over synchronous and ISDN links, with logical
interfaces, congestion control and a slowstart mechanism.

• Bandwidth management, multilink PPP channel aggregation,
network on demand and bandwidth on demand.

• Hardware-based data encryption and compression.

• Traffic shaping and Quality of Service (QoS) with the
Resource Reservation Protocol (RSVP) and Bandwidth
Allocation Control Protocol (BACP).

• X.25 communications server.

• TDM (Time Division Multiplexing).

• Automated network monitoring and control with a
sophisticated, configurable event logging facility.

• Triggers for automatic and timed execution of commands,
and scripting for automated configuration and centralised
management of configurations.

• Support for the Simple Network Management Protocol
(SNMP) allows the router to be managed by a separate
network management station.

ABOUT THIS GUIDE

Before you use your AR745 router in a live network, please
read this guide. This guide contains the following:

• Instructions for and connecting the router to different physical
networks and network services.

• Instructions for installing the AR Series Router Documentation
and Tools CD-ROM and using the online documentation.

• Simple ‘get-you-running’ instructions for the most popular IP
and Novell® IPX applications, using the router’s command
line interface.

WHERE TO FIND SAFETY AND STATUTORY

INFORMATION

Safety and statutory information can be found in the AR700
Series Router Safety and Statutory Information booklet. This
booklet can be found on the CD-ROM bundled with your
router, or at www.alliedtelesyn.co.nz.
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Getting Connected

This section describes how to connect the AR745 router to
different physical devices and networks. Before you start, you
should be aware that the AR745 router refers to its physical
interfaces as ports and these are numbered, starting at 0. Ports
on the base unit are numbered first, followed by ports on PICs
(Port Interface Cards) in Bay 0 and Bay 1, then by ports on an
NSM installed in the NSM bay. For example, eth0 is the first
Ethernet port and syn1 is the second synchronous port.

USING WINDOWS TERMINAL OR WINDOWS

HYPERTERMINAL AS THE CONSOLE

You can use a PC running terminal emulation software as the
manager console, instead of a terminal. There are many terminal
emulation applications available for the PC, but the most readily
available are the Terminal and HyperTerminal applications
included in Microsoft® Windows™ 3.1 and Windows 95,
respectively. In a normal Windows™ installation Terminal is
located in the Accessories group. In Windows 95 HyperTerminal
is located in the Start > Programs > Accessories menu.

The key to using terminal emulation software successfully with
the AR745 router is to configure the communications
parameters in the terminal emulation software to match the
default settings of the console port on the router. The following
procedures describe how to configure Windows™ Terminal and
HyperTerminal for the default console port settings on the
AR745 router, but the same principles apply to other terminal
emulation programs.

To configure Windows™ Terminal, follow these steps:

1   In Windows 3.1, double-click the Terminal icon in the
Accessories group in Program manager.

2   Select “Communications” from the Settings menu. The
Communications dialog box is displayed.

3   Select “Terminal Emulation” from the Settings menu. In the
Terminal Emulation dialog box check “DEC VT-100 (ANSI)” and
click “OK”.

4   Select “Terminal Preferences” from the Settings menu. In the
Terminal Preferences dialog box uncheck “Local Echo”, “CR ->
CR/LF”, and “Use Function, Arrow, and Ctrl Keys for Windows”.
Set other parameters as required, then click “OK”.

Set “Baud Rate” to 9600, “Data Bits” to 8, “Stop Bits” to 1,
“Parity” to None, “Flow Control” to Hardware and “Connector”
to the COM port on the PC used to connect to the router.
Uncheck the “Parity Check” and “Carrier Detect” checkboxes.
Click “OK” to accept the new settings and close the dialog box.
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5   To save the configuration, select “Save As” from the File
menu, then type a file name and press [Enter]. To reuse the
configuration in a future session, select “Open” from the File
menu, select the file name from the list and click “OK”.

6   You can customise Windows™ Terminal further by assigning
commonly used router commands to function keys. Select
“Function Keys” from the Settings menu, or select “Contents”
from the Help menu and click on the topic “Assign Tasks to
Function Keys”. To save the function key assignments, follow
step 5 above.

To configure Windows 95 HyperTerminal, follow these steps:

1   In Windows 95, from the Start Menu, select Programs >
Accessories > HyperTerminal to display the HyperTerminal
group. Double-click the Hypertrm.exe icon.

2   In the Connection Description dialog box, enter a name for
the connection (e.g. AR745) and select an icon from the
scrolling list. Click “OK”.

3   In the Phone Number dialog box, from the “Connect using:”
dropdown list select the “Direct to Com n” to match the COM
port on the PC used to connect to the router. Click “OK”.

4   In the COMn Properties dialog box set “Bits per second” to
9600, “Data bits” to 8, “Parity” to None, “Stop bits” to 1 and
“Flow control” to Hardware. Click “OK”.

5   Select “Properties” from the File menu. In the Connection
Properties dialog box, click the Settings tab and set “Function,
arrow, and ctrl keys act as” to “Terminal keys” and “Emulation”
to VT100.

6   Click “ASCII Setup” to display the ASCII Setup dialog box.
Uncheck the “Echo typed characters locally” and “Append line
feeds to incoming line ends” checkboxes. Set other parameters
as required, then click “OK” twice to dismiss all dialog boxes.
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7   Select “Save” from the File menu to save the current session.
This creates a connection icon with the name you assigned in
the HyperTerminal group. To use the configuration, double-click
the connection icon in the HyperTerminal group. When the
HyperTerminal window appears, press [Enter] a couple of times.
The router’s login prompt will appear.

CONNECTING TO AN ETHERNET LAN

To connect the AR745 router to an Ethernet LAN, follow
these steps:

1   The Ethernet port on the AT-AR022 Ethernet PIC is a
10 Mbps port with dual AUI and TP interfaces. Connect the
Ethernet LAN to only one of the interfaces. The PIC will
automatically sense which interface is in use. The Ethernet
ports on the AR745 base unit are 10/100 Fast Ethernet ports
with RJ45 TP interfaces.

2   To connect the AR745 to the Ethernet LAN via a TP
interface, use the supplied CAT 5 Ethernet cable or an
approved equivalent. To connect the AR745 to the Ethernet
LAN via an AUI interface, use a transceiver.

L /A L /ASWAP

IN 100M
ETHERNET 1

EN

PIC 1

PIC 0100M
ETHERNET 0

DISCONNECT POWER BEFORE INSTAL

Connect the LAN to an Ethernet port on the rear panel of the AR745 using the

supplied CAT 5 cable.
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Connect the LAN to the TP port on the rear panel of the AT-AR022 Ethernet PIC

using the supplied CAT 5 cable. Use a transceiver to connect the AUI port to the LAN.

3   Check the operation by observing the state of the LEDs on
the rear panel of the router or PIC. The Tx and Rx LEDs will be
lit as data is transmitted and received via the interface. The Lnk
LED (if present) will be lit when the Ethernet port is connected
to a hub, PC or a LAN with at least one other device attached.

CONNECTING TO A LEASED LINE CIRCUIT

To connect the AR745 router with an AT-AR023 SYN PIC
installed to a synchronous leased line circuit, follow these steps:

1   Using the appropriate approved transition cable (RS-232,
X.21 or V.35), connect the synchronous port on the rear panel
of the AT-AR023 SYN PIC to the telecommunication service
provider’s NTU.

SYN
Tx

Rx

Connect the NTU to the synchronous port on the rear panel of the AT-AR023 SYN

PIC using the appropriate approved transition cable.
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2   Connect the supplied CAT 5 cable, or an approved ISDN cable,
from the BRI interface on the rear panel of the AT-AR021(S)
PIC to the ISDN service provider’s termination point (NT1).

B
R

I S
/T Active

D

B1

B2

Connect the supplied CAT 5 cable or an approved ISDN cable from the BRI port on

the rear panel of the AT-AR021(S) BRI-S/T PIC to the NT1.

Note: If you wish to make your own ISDN cable, see the AR Router
Hardware Reference for a detailed description of how to wire an
ISDN interface cable.

3   Check the operation by observing the state of the LEDs on
the rear panel of the AT-AR021(S) PIC. In some territories (e.g.
New Zealand and the European Union) the Active LED will be
lit if the link to the NT1 is operational. In other territories (e.g.
Australia) the Active LED will only be lit when the router
attempts a call. The D LED will flicker as control traffic is
exchanged with the ISDN switch. The B1 and B2 LEDs will
flicker as data is sent and received on the B1 and B2 channels.

To test the AT-AR021 PIC you will need to configure a routing
protocol such as IP or IPX to use ISDN. See Configuring ISDN,
Configuring an IP Network and Configuring a Novell IPX Network
later in this guide for more information about configuring ISDN
calls and routing protocols.

CONNECTING TO A BASIC RATE U ISDN SERVICE

To connect an AR745 router with an AT-AR021(U) BRI-U PIC
installed to a Basic Rate U ISDN service, follow these steps:

1   Connect the supplied CAT 5 cable or an approved ISDN
cable from the BRI interface on the rear panel of the
AT-AR021(U) PIC to the ISDN service provider’s termination
point (ISDN line wall jack).

Active

B
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D

B1

B2

Connect the supplied CAT 5 cable, or an approved ISDN cable, from the BRI port on

the rear panel of the AT-AR021(U) BRI-U PIC to the ISDN line wall jack.

2   Check the configuration of the port, by typing the command:

SHOW SYN=n

where n is the synchronous port number. Verify that the
information displayed is correct. In particular, “State” should be
set to “enabled” and “Interface type” should match the
transition cable used.

3   Configure a data link layer module, such as PPP (Point-to-Point
Protocol), Frame Relay or X.25 LAPB, to use the synchronous
interface. To create a PPP interface 0 to use synchronous port 0,
type the command:

CREATE PPP=0 OVER=SYN0

4   Check the configuration by typing the commands:

SHOW SYN=0
SHOW PPP=0

The output of the SHOW SYN command should show “Active”
set to “yes” and “Module” set to “ppp”. The output of the
SHOW PPP command should show interface ppp0 over syn0
with “LCP” as the control protocol. The Tx and Rx LEDs will be
lit as data is sent and received on the interface.

ORDERING ISDN IN THE USA AND CANADA

In the United States and Canada, Basic Rate ISDN is provided
using National ISDN-1, 5ESS or DMS-100 formats, all of which
are supported by the AR745 router. If National ISDN-1 is
available, you can select from a list of “Capability Packages”,
each providing different features. Contact your ISDN service
provider for more information. The AR745 router will accept
either one or two Service Profile Identifiers (SPIDs).

CONNECTING TO A BASIC RATE S/T ISDN SERVICE

Warning: The factory default hardware settings described
here are correct for European Union (EU) countries. For
other countries, contact your distributor or reseller for
details of local requirements.

To connect an AR745 router with an AT-AR021(S) BRI-S/T PIC
installed to a Basic Rate S/T ISDN service, follow these steps:

1   Check that the AT-AR021(S) BRI-S/T PIC has the correct
termination for the local conditions. The AT-AR021(S) PIC can
only operate in TE mode and is shipped with the standard
100Ω termination jumpers removed. This is appropriate for
most situations, where the local building wiring provides the
ISDN termination. Your distributor or reseller can advise you
whether or not termination jumpers are required.
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Connect the Primary Rate ISDN port on the rear panel of the AT-AR020 PRI E1/T1

PIC to the ISDN service provider’s termination point using an approved ISDN 120Ω
cable or external balun.

3   Check the operation by observing the state of the LEDs on
the front panel of the AT-AR020 PIC. The “Active” LED should
be lit indicating the link to the NT is operational. The “D Data”
LED will flicker as control traffic is exchanged with the ISDN
switch. The “B Data” LED will flicker as data is transmitted and
received on any B channel. The “NT” LED indicates that the PRI
interface is in NT mode, and should not be lit during normal
operation. See Configuring ISDN, Configuring an IP Network and
Configuring a Novell IPX Network later in this guide for more
information about configuring ISDN calls and routing protocols.

CONNECTING A TERMINAL OR MODEM

To connect a terminal or modem to an asynchronous port on
the AR745 router, follow these steps:

1   Use the supplied console cable or an approved terminal
cable to connect a terminal to an asynchronous port on the
rear panel of the router or the rear panel of an AT-AR024
ASYN4 PIC. Use an approved modem cable to connect a
modem to an asynchronous port on the rear panel of the
router or the rear panel of an AT-AR024 ASYN4 PIC.

Note: If you wish to make your own cable, see the AR Router
Hardware Reference for a detailed description of how to wire a
terminal or modem cable.

NGINE

ACT

PWR

DAT

RUN

ER

SYS

CLR

SEC
PORT 1 PORT 0

PIC 0

BASE

LLING/REMOVING PIC

Connect the terminal or modem to an asynchronous port (Port 0 or Port 1) on the

rear panel of the AR745 router using an approved cable.

Note: If you wish to make your own ISDN cable, see the AR Router
Hardware Reference for a detailed description of how to wire an
ISDN interface cable.

2   Check the operation by observing the state of the LEDs on
the rear panel of the AT-AR021(U) PIC. The Active LED will be lit
when the U interface is activated and operational at the physical
layer. The D LED will flicker as control traffic is exchanged with
the ISDN switch. The B1 and B2 LEDs will flicker as data is sent
and received on the B1 and B2 channels.

To test the AT-AR021(U) PIC you will need to configure a
routing protocol such as IP or IPX to use ISDN. See Configuring
ISDN, Configuring an IP Network and Configuring a Novell IPX
Network later in this guide for more information about
configuring ISDN calls and routing protocols.

CONNECTING TO A PRIMARY RATE ISDN SERVICE

To connect an AR745 router with an AT-AR020 PRI E1/T1 PIC
installed to a Primary Rate ISDN service, follow these steps:

1   Check that the AT-AR020 PRI E1/T1 PIC has the correct
mode and termination for local conditions. The AT-AR020 PRI
E1/T1 PIC is shipped pre-configured for normal LT operation in
T1 mode, with the standard termination jumpers removed. This
is appropriate for most situations. If the PIC is to be operated
in a non-standard mode, contact your distributor or reseller.
The commands:

SHOW PRI STATE
SHOW PRI CONFIGURATION

display the state of the PRI interface and the modules configured
to use the PRI interface. Check the output of the SHOW PRI
STATE command that “ISDN Interface type” is set to “TE”.  If not,
contact your distributor or reseller for assistance, or see the AR
Series Router Reference Manual for more information.

2   Connect an approved ISDN 120Ω cable from the ISDN
service provider’s termination point to the PRI interface on the
rear panel of the AT-AR020 PRI E1/T1 PIC. If the router is
being connected to a 75Ω network, an external balun is
required. Contact your distributor, reseller or ISDN service
provider for assistance.

Note: If you wish to make your own ISDN cables, see the AR Router
Hardware Reference for a detailed description of how to wire an
ISDN interface cable.
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Connect the terminal or modem to an asynchronous port on the rear panel of the

AT-AR024 ASYN4 PIC using an approved cable.

2   Check that the terminal or modem’s communication
settings match the settings of the asynchronous port. By default,
asynchronous ports on the AR745 router are set to 9600 baud,
8 data bits, 1 stop bit, no parity and hardware flow control.
Refer to the user manual supplied with the terminal or modem
for details of how to change the communications settings for the
terminal or modem.

If the terminal or modem is to be used with communications
settings other than the default settings, the asynchronous port
must be configured to match the terminal or modem settings
using the SET PORT command. If a modem is being connected,
the CDCONTROL parameter must be set to “CONNECT” and
the FLOW parameter must be set to “HARDWARE”. See the
router’s online help or the AR Series Router Software Reference for
more information.

3   If a modem is being connected, the router must be configured
to make and/or accept calls via the modem. See the router’s
online help or the AR Series Router Software Reference for
more information.
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Documentation and Tools CD-ROM

The AR Series Router Documentation and Tools CD-ROM is
bundled with every AR router and includes:

• The AR Series Router Documentation Set in Adobe Acrobat
PDF format—the complete reference to installing,
configuring and managing the AR series of multiprotocol
routers, including detailed descriptions of all commands.

• Application Notes—a collection of technical and background
papers on the application of AR router technologies.

• Configuration Examples—a collection of ready-to-use
examples of typical network configurations, complete with
scripts to download to an AR router using AT-TFTP.

• AT-TFTP Server for Windows, for downloading software
releases, scripts and other files to or from an AR router.

• Adobe Acrobat Reader for Windows for viewing and
printing the online documentation in PDF format.  Get
instant access to information with full-text searching of PDF
documents by keyword or phrase.

• Microsoft Internet Explorer and Netscape Communicator.

• Demonstration versions of networking utilities, such as
AR-Remote File Manager (AR-RFM) from Allied Telesyn and
F-Secure’s Secure Shell client for Windows.

USING THE CD-ROM

To use the CD-ROM, follow these steps:

1   Insert the CD-ROM in the CD-ROM drive.

2   If the CD Browser menu does not appear automatically
after a few seconds, select “Run” from the Start Menu and type
d:\start.exe (where d: is the CD-ROM drive letter). Click OK.

3   To view a document, click on the document title. To navigate
around PDF documents, do one of the following:

• Use the toolbar buttons, keyboard shortcuts, and commands
from the Document menu to page through the document.

• Click on a bookmark, thumbnail or hypertext link to jump
to a specific section or topic.

• Use the Search command to search for keywords or
phrases.

For more information about using the Adobe Acrobat Reader,
select “Acrobat Reader Help” from the Help menu.

4   To install any of the tools on the CD-ROM, click on the
“Tools” button in the CD Browser menu.

USING AT-TFTP SERVER

To use AT-TFTP Server, follow these steps:

1   If AT-TFTP Server has not yet been installed, install it now
from the AR Series Router Documentation and Tools
CD-ROM.

2   Select AT-TFTP Server from the Start > Programs > Allied
Telesyn > AT-TFTP Server menu.

3   To set preferences for the AT-TFTP Server, select “Options”
from the File menu to display the “Set Preferences” dialog box.

The “Default file transfer directory” field specifies the directory
AT-TFTP Server will read from or write to, for file requests
that do not include a directory specification.

To prevent unauthorised access to private directories, enter a
path name in the “Restrict to directory” field. AT-TFTP Server
will use only the specified directory, even if file requests contain
references to other directories.

Select “Read only” to prevent files being written to the PC. To
use the PC to archive router scripts created using the router’s
CREATE CONFIG command, select “Read Write”.

Make any required changes and click “OK”.

4   To load a file from AT-TFTP Server to the router, on a
terminal connected to the router type the command:

LOAD METHOD=TFTP FILE=filename
SERVER=ipadd DEST=FLASH

where filename is the name of the file to download and ipadd is
the IP address of the PC running AT-TFTP Server.

5   TFTP requests are logged to the AT-TFTP Server main
window. To save the log, select “Save As” from the File menu.
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3   In countries other than the USA, the router’s ISDN directory
numbers and subaddresses may be set with
the command:

SET Q931=0 NUM1=number NUM2=number
SUB1=subaddress SUB2=subaddress

This step is only required if the router is sharing the ISDN S/T
bus with other ISDN devices. See the AR Series Router Software
Reference for more information.

Go to Step 5.

4   In the USA, the ISDN switch type and SPIDs values may also
need to be set. Setting the system territory to USA
automatically sets the ISDN switch type to National ISDN-1.
This should be correct for all new ISDN installations. If the
router is to be connected to another switch type, the switch
type can be set with the command:

SET Q931=0 PROFILE=DMS-100

for a Northern Telecom DMS-100 switch running custom
software, or:

SET Q931=0 PROFILE=5ESS

for a Lucent 5ESS switch running custom software.

If the switch type is not National ISDN-1, the SPIDs (supplied
by the ISDN service provider) must also be entered with
the command:

SET Q931=0 SPID1=spid SPID2=spid

If the switch type is National ISDN-1 the router will, when first
turned on, attempt to obtain the SPIDs itself from the switch
using the Auto SPID procedures. The success of this procedure
can be monitored with the command:

SHOW Q931=0 SPID

If the Auto SPID procedure succeeds the router will either
select the SPID values to use by itself, or tell the user (in the
output of the SHOW Q931=0 SPID command) how to select
the SPID values.

If the Auto SPID procedures fail, SPIDs can be entered manually
with the command:

SET Q931=0 SPID1=spid SPID2=spid

This section describes how to configure ISDN on the AR745
router using the command line interface. ISDN on the router
requires minimal user configuration, other than selecting a
territory, creating call definitions and configuring the Point-to-
Point Protocol (PPP) to use the ISDN calls. The lower layers of
the ISDN protocol stack (BRI, LAPD and Q.931) are
automatically configured when the router starts up.

Warning: The factory default hardware and software settings
described here are correct for European Union (EU)
countries. For other countries, contact your distributor or
reseller for details of local requirements.

CONFIGURING BASIC RATE ISDN

To configure Basic Rate ISDN on the AR745 router, follow
these steps:

1   Check the BRI hardware configuration. The AR745 router
can only operate in TE mode and is shipped with the standard
100Ω termination jumpers removed. This is appropriate for
most situations, where the building wiring provides the ISDN
termination. Your distributor or reseller can advise you whether
or not termination jumpers should be installed.

2   Select the country in which the router is being operated,
using the command:

SET SYSTEM TERRITORY={AUSTRALIA|CHINA|
EUROPE|JAPAN|KOREA|NEWZEALAND|USA}

The territory determines which Q.931 profile is used on the
ISDN interface. For example, to select the Q.931 profile for the
United States, use the command:

SET SYSTEM TERRITORY=USA

Warning: If you are not sure which territory to use, contact
your distributor or reseller. Failure to select the correct
territory will invalidate the approval of this product with
respect to the applicable national standards for the
country in which the product is used.

For installations in the USA, go to step 4. For installations in
other countries, go to step 3.

Configuring ISDN
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same time), one call is completed and other call is cleared. The
direction of precedence is not important, but it must be set to
IN at one end of the call and OUT at the other end of the call.

The ISDN number is the exact sequence required to reach the
remote router from the local router, including STD access
codes and area codes. The number may contain only decimal
digits. Hyphens and other characters will result in an error.

Check that the ISDN calls have been successfully added with
the command:

SHOW ISDN CALL

6   Create PPP interfaces to use the ISDN calls. PPP provides
the link layer protocol and enables multiple network and
transport layer protocols such as IP and Novell® IPX to be
carried over the same ISDN link.

For example, on the Head Office router create PPP interface 0
to use the ISDN call ROHO:

CREATE PPP=0 OVER=ISDN-ROHO

On the Remote Office router, create PPP interface 0 to use the
ISDN call ROHO:

CREATE PPP=0 OVER=ISDN-ROHO

Check the configuration with the commands:

SHOW ISDN CALL

SHOW PPP

The call ROHO should appear in the output of the SHOW
ISDN CALL command. The output of the SHOW PPP
command should show interface ppp0 over ISDN-ROHO.

ISDN is now ready to be used by routing protocols such as IP
and IPX.

CONFIGURING PRIMARY RATE ISDN

To configure Primary Rate ISDN on the AR745 router, follow
these steps:

1   The AR745 can operate in either TE or NT mode, using 75Ω
or 120Ω termination. The router is shipped with jumpers set to
TE mode, 75Ω termination, Tx grounded and Rx grounded via a
100nF capacitor. This is appropriate for most situations. Your
distributor or reseller can advise you whether or not grounding
jumpers should be installed.

Warning: Disconnect the router from the mains power
supply before removing the router lid.

Directory numbers and subaddresses can be entered with
the command:

SET Q931=0 NUM1=number NUM2=number
SUB1=subaddress SUB2=subaddress

The directory numbers and subaddresses must be supplied by
the ISDN service provider. If the directory number is a full 10
digit number (3 digit area code plus 7 digit number), the router
will append the digits “0101” to the number and attempt SPID
initialisation with the result. This is known as the Generic SPID
procedure. If SPID initialisation has already taken place and
SPIDs have been obtained through the Auto SPID procedure,
then either these SPIDs are the same as the Generic SPID and
the router will successfully reinitialise, or the SPIDs are not the
same as the Generic SPID and the router will not initialise. In
this case, the router will revert to using the Auto SPID values.

5   Create ISDN call definitions to enable the router to make
ISDN calls to other devices on the ISDN network. This is the
only step that must be completed to configure ISDN on the
router. Before a call can be made from one router to another,
call definitions must be created on both routers, using
the command:

ADD ISDN CALL=name NUMBER=number
PRECEDENCE={IN|OUT} options...

For example, a Remote Office router is to be connected to the
Head Office router via ISDN. The ISDN number of the Remote
Office router is 1234567. The ISDN number of the Head Office
router is 9876543. The called party subaddress information
element (IE) is used to carry connection information, and PPP
interfaces will be created explicitly to use the ISDN calls. Either
router can initiate the call, but calls from the Remote Office
have precedence. On the Head Office router, create a call to
the Remote Office router:

ADD ISDN CALL=ROHO OUTSUB=LOCAL
SEARCHSUB=LOCAL NUMBER=1234567 PREC=IN

On the Remote Office router, create a call to the Head
Office router:

ADD ISDN CALL=ROHO OUTSUB=LOCAL
SEARCHSUB=LOCAL NUMBER=9876543
PREC=OUT

Each call has the same name (ROHO), and this name is passed
via the called subaddress IE to provide identification to the
remote end of the link. Each router will search for this call
using the called subaddress IE.

The precedence must be set to ensure that in the event of a
call collision (the same call being made and answered at the
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2   Select the country in which the router is being operated,
using the command:

SET SYSTEM TERRITORY={AUSTRALIA|CHINA|
EUROPE|JAPAN|KOREA|NEWZEALAND|USA}

The territory determines which Q.931 profile is used on the
ISDN interface. For example, to select the Q.931 profile for
New Zealand, use the command:

SET SYSTEM TERRITORY=NEWZEALAND

Warning: If you are not sure which territory to use, contact
your distributor or reseller. Failure to select the correct
territory will invalidate the approval of this product with
respect to the applicable national standards for the
country in which the product is used.

3   The router’s ISDN directory numbers and subaddresses may
be set with the command:

SET Q931=0 NUM1=number NUM2=number
SUB1=subaddress SUB2=subaddress

This step is only required if the router is sharing the ISDN S/T
bus with other ISDN devices. See the AR Series Router Software
Reference for more information.

4   Create ISDN call definitions to enable the router to make
ISDN calls to other devices on the ISDN network. This is the
only step that must be completed to configure ISDN on the
router. Before a call can be made from one router to another,
call definitions must be created on both routers, using
the command:

ADD ISDN CALL=name NUMBER=number
PRECEDENCE={IN|OUT} options...

For example, a Remote Office router is to be connected to the
Head Office router via ISDN. The ISDN number of the Remote
Office router is 1234567. The ISDN number of the Head Office
router is 9876543. The called party subaddress information
element (IE) is used to carry connection information, and PPP
interfaces will be created explicitly to use the ISDN calls. Either
router can initiate the call, but calls from the Remote Office
have precedence. On the Head Office router, create a call to
the Remote Office router:

ADD ISDN CALL=ROHO OUTSUB=LOCAL
SEARCHSUB=LOCAL NUMBER=1234567 PREC=IN

On the Remote Office router, create a call to the Head
Office router:

ADD ISDN CALL=ROHO OUTSUB=LOCAL
SEARCHSUB=LOCAL NUMBER=9876543
PREC=OUT

Each call has the same name (ROHO), and this name is passed
via the called subaddress IE to provide identification to the
remote end of the link. Each router will search for this call
using the called subaddress IE.

The precedence must be set to ensure that in the event of a
call collision (the same call being made and answered at the
same time), one call is completed and other call is cleared. The
direction of precedence is not important, but it must be set to
IN at one end of the call and OUT at the other end of the call.

The ISDN number is the exact sequence required to reach the
remote router from the local router, including STD access
codes and area codes. The number may contain only decimal
digits. Hyphens and other characters will result in an error.

Check that the ISDN calls have been successfully added with
the command:

SHOW ISDN CALL

5   Create PPP interfaces to use the ISDN calls. PPP provides
the link layer protocol and enables multiple network and
transport layer protocols such as IP and Novell® IPX to be
carried over the same ISDN link.

For example, on the Head Office router create PPP interface 0
to use the ISDN call ROHO:

CREATE PPP=0 OVER=ISDN-ROHO

On the Remote Office router, create PPP interface 0 to use the
ISDN call ROHO:

CREATE PPP=0 OVER=ISDN-ROHO

Check the configuration with the commands:

SHOW ISDN CALL

SHOW PPP

The call ROHO should appear in the output of the SHOW
ISDN CALL command. The output of the SHOW PPP
command should show interface ppp0 over ISDN-ROHO.

ISDN is now ready to be used by routing protocols such as IP
and IPX.
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CONFIGURING ISDN DIAL ON DEMAND

A PPP interface that uses an ISDN call as its physical interface
can be configured for dial on demand operation. The ISDN call
is activated only when there is data to be transmitted, and is
disconnected when the link has been idle for a period of time.

To configure ISDN dial on demand operation, follow these steps:

1   Complete steps 1 to 5 of Configuring Basic Rate ISDN, or
steps 1 to 4 of Configuring Primary Rate ISDN above.

2   Create PPP interfaces to use the ISDN calls and enable the
IDLE timer. Using the example in step 6 of Configuring Basic Rate
ISDN above, on the Head Office router create PPP interface 0
to use the ISDN call ROHO:

CREATE PPP=0 OVER=ISDN-ROHO IDLE=ON

On the Remote Office router, create PPP interface 0 to use the
ISDN call ROHO:

CREATE PPP=0 OVER=ISDN-ROHO IDLE=ON

Setting the IDLE parameter to ON enables the idle timer
and sets the timeout period to 60 seconds. ISDN calls will be
disconnected if there has been no data transmitted over the
link for 60 seconds. To enable the idle timer with a different
timeout period, specify a time in seconds instead of the
value ON.

PPP interface 0 is now configured for dial on demand operation
and any routing protocols such as IP and IPX that are
configured to use PPP interface 0 will automatically inherit the
dial on demand functionality.

CONFIGURING ISDN BANDWIDTH ON DEMAND

A PPP interface can be configured to use up to two B channels
on an ISDN Basic Rate interface, to provide bandwidth on
demand. PPP activates additional ISDN channels when the
bandwidth exceeds an upper threshold, and deactivates ISDN
channels as bandwidth falls below a lower threshold.

To configure an ISDN connection for bandwidth on demand
operation, follow these steps:

1   Complete steps 1 to 5 of Configuring Basic Rate ISDN, or
steps 1 to 4 of Configuring Primary Rate ISDN above.

2   Create a second ISDN call on each router, identical to the
call ROHO but with the name DEMAND.

3   Create PPP interfaces to use the ISDN calls, enable the
IDLE timer and add a second demand channel. Using the
example in  step 6 of Configuring Basic Rate ISDN or step 5 of
Configuring Primary Rate ISDN above, on the Head Office router
create PPP interface 0:

CREATE PPP=0 OVER=ISDN-ROHO IDLE=ON

ADD PPP=0 OVER=ISDN-DEMAND TYPE=DEMAND

On the Remote Office router, create PPP interface 0:

CREATE PPP=0 OVER=ISDN-ROHO IDLE=ON

ADD PPP=0 OVER=ISDN-DEMAND TYPE=DEMAND

PPP interface 0 is now configured for bandwidth on demand
operation and any routing protocols such as IP and IPX that are
configured to use PPP interface 0 will automatically inherit the
bandwidth on demand functionality.



A R 7 4 5  R O U T E R  Q U I C K  S T A R T  G U I D E 17

Protocol (PPP) over a wide area link. Each router is attached to
an Ethernet LAN on which there is a mixture of PCs and hosts.

BEFORE YOU START

1   Ensure that the routers to be configured are connected to
the Ethernet LAN and the wide area link, and that the link is
operational. See Getting Connected for information about
connecting the router to a physical network.

2   Connect a terminal to the console port (port 0) on each
router, as described in the AR700 Series Router Quick Install
Guide. Alternatively, you can connect a PC to the console port
and use a terminal emulation program like Windows™ Terminal.

Configuring an IP Network

Head Office Router Remote Office Router

172.16.254.2

Remote PC Remote PC

172.16.254.1

172.16.8.33 192.168.31.30
172.16.8.0 192.168.31.16

TCP/IP Host Local PC

PPP Data Link

Head Office Router Configuration Parameter Remote Office Router

eth0 Ethernet interface eth0

172.16.8.33 Ethernet interface IP address 192.168.31.30

172.16.8.0 Ethernet LAN IP subnet address 192.168.31.16

255.255.255.0 Ethernet LAN IP subnet mask 255.255.255.240

ppp0 PPP interface ppp0

172.16.254.1 PPP interface IP address 172.16.254.2

172.16.254.0 PPP interface IP subnet address 172.16.254.0

255.255.255.0 PPP interface IP subnet mask 255.255.255.0

TCP/IP is the most widely used network protocol. The Internet
uses TCP/IP for routing all its traffic. TCP/IP provides a range of
services including remote login, Telnet, file transfer (FTP), Email
and access to the World-Wide Web.

The AR745 router routes TCP/IP across the wide area network
using services like ISDN, Frame Relay and leased lines, enabling
remote TCP/IP LANs to be joined together as a single internet
to exchange information.

This example illustrates the steps required to configure TCP/IP
using the router’s command line interface. Two routers running
TCP/IP will be connected together using the Point-to-Point
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3   Login to the MANAGER account on each router, as
described in the AR700 Series Router Quick Install Guide.

4   Collect together the information that you will need to
configure IP. We recommend you photocopy the table on the
previous page and fill in the details.

CONFIGURING IP

The following steps are required:

1. Configure the PPP Link.

2. Configure the IP routing module on both routers.

3. Test the configuration.

Configure the PPP Link

Configure PPP interface 0 on each router to use the wide area
link. See Getting Connected for information about configuring
PPP to use a synchronous link. See Configuring ISDN for
information about configuring PPP to use an ISDN call. If the
PPP interface is configured for dial on demand operation (see
Configuring ISDN Dial on Demand) or bandwidth on demand
operation (see Configuring ISDN Bandwidth on Demand), these
services will automatically be used by the IP routing software.

Configure IP Routing

1   Clear any pre-existing IP configuration and turn on the IP
routing software on each router, using the commands:

PURGE IP

ENABLE IP

2   On the Head Office router define two IP interfaces, one for
the Ethernet LAN and one for the wide area link:

ADD IP INT=ETH0 IP=172.16.8.33
MASK=255.255.255.0

ADD IP INT=PPP0 IP=172.16.254.1
MASK=255.255.255.0

3   Repeat this procedure on the Remote Office router,
defining one IP interface for the Ethernet LAN and one for the
wide area link:

ADD IP INT=ETH0 IP=192.168.31.30
MASK=255.255.255.240

ADD IP INT=PPP0 IP=172.16.254.2
MASK=255.255.255.0

4   A routing protocol, such as RIP, can be enabled so that the
routers can exchange information about routes to all of the IP
devices (hosts, PCs, file servers, etc.) on the internet. However,
on a dial-on-demand ISDN connection this may result in

excessive call charges. So for this example static routes will be
defined. On the Head Office router enter the command:

ADD IP ROUTE=192.168.31.0
MASK=255.255.255.240 INT=PPP0
NEXT=172.16.254.2

5   Repeat this procedure for the Remote Office router,
entering the command:

ADD IP ROUTE=172.16.8.0
MASK=255.255.255.0 INT=PPP0
NEXT=172.16.254.1

6   The IP routing software is now configured and operational
on both routers.

Test the Configuration

The IP configuration can now be checked using the following
commands and then functionally tested by establishing a Telnet
(remote access) connection to the remote router.

1   To check the routes, type (on either router):

SHOW IP ROUTE

This should produce a display (on the Head Office router) like
that shown on page 19. For each router, there should be a
route to the LAN and PPP interfaces on the local router and a
route to the LAN interface on the remote router.

2   Test the PPP link between the two routers using the PING
command on each router to send ping packets to the router at
the remote end of the PPP link. On the Head Office router use
the command:

PING 192.168.31.30

On the Remote Office router use the command:

PING 172.16.8.33

Within a few seconds the router will display a message like:

Echo reply 1 from 172.16.8.33 time delay
20 ms

indicating a response was received from the router at the
remote end of the PPP link.

Note: We have used the Ethernet address in this example but you
can ping any of the remote router’s assigned IP addresses.

3   To functionally test the connection between the two
routers, use Telnet to establish a connection to the remote
router. Enter the following command on the Head Office
router to connect to the Remote Office router:

TELNET 192.168.31.30
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If the route still does not appear, contact your distributor or
reseller for assistance.

Telnet Fails

1   If Telnet to a router fails, check that the IP address you used
matches the one assigned to the router. Check that RIP is
configured correctly (steps 4 and 5 above). Check that the IP
Telnet server is enabled on each router, using the command:

SHOW IP

If the Telnet server is disabled, enable the Telnet server with
the command:

ENABLE IP TELNETSERVER

2   If Telnet into a host on the remote LAN fails, but works into
the remote router, check the IP address you are using is correct.
Check that both routers are gateways, not servers by typing:

SHOW IP

The “IP Packet Forwarding” field in the output should be set to
“Enabled”. The host’s TCP/IP software should be configured to
use the Head Office router as its gateway. Refer to the
documentation for the host TCP/IP software for more
information about configuring a gateway.

3   Contact your distributor or reseller for assistance.

You will see the login screen for the Remote Office router. To
connect from the Remote Office router to the Head Office
router, on the Remote Office router use the command:

TELNET 172.16.8.33

Note: We have used the Ethernet address in this example but you
can Telnet to any of the remote router’s assigned IP addresses.

Save the Configuration

Save the new dynamic configuration as a script, by entering
the command:

CREATE CONFIG=IPCONF.SCP

TROUBLESHOOTING IP CONFIGURATIONS

No Route Exists to the Remote Router

1   Wait for at least one minute to ensure that a RIP update has
been received.

2   Repeat steps 4 and 5 above. Check that the PPP link is
OPENED for both LCP and IP by entering the command:

SHOW PPP

The display should look like that shown above.

3   Try restarting the IP routing software (a warm restart), by
entering the command:

RESET IP

Example output from the SHOW IP

ROUTE command for a basic TCP/IP

network.

IP Routes
-------------------------------------------------------------------------------
Destination       Mask              Nexthop             Interface           Age
DLCI/Circ.        Type     Policy   Protocol            Metric       Preference
-------------------------------------------------------------------------------
172.16.8.0        255.255.255.0     0.0.0.0             eth0               1382
-                 direct   0        interface           1                     0
172.16.31.16      255.255.255.240   172.16.254.2        ppp0                 71
-                 remote   0        static              2                   100
172.16.254.0      255.255.255.0     0.0.0.0             ppp0               1382
-                 direct   0        interface           1                     0
-------------------------------------------------------------------------------

Example output from the SHOW PPP

command for a basic TCP/IP network. Name            Enabled  ifIndex  Over                  CP           State
-----------------------------------------------------------------------------
ppp0              YES      04                           IPCP         OPENED
                                  isdn-roho             LCP          OPENED
-----------------------------------------------------------------------------
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Configuring a Novell IPX Network

Head Office Router

Network = 401

Remote Office Router

Network = 12

Netware
File Server

Remote PC Remote PC

PPP Data Link

Network = 129

Head Office Router Configuration Parameter Remote Office Router

eth0 Ethernet interface eth0

802.3 Ethernet encapsulation 802.3

401 Novell network number for Ethernet 12

1 IPX circuit over Ethernet 1

ppp0 PPP interface ppp0

129 Novell network number for PPP 129

2 IPX circuit over PPP 2

This example illustrates the steps required to configure a pair of
AR745 routers to create a Novell® IPX internetwork, using the
router’s command line interface. In this scenario, PCs at a
remote office need access to a Novell file server at the Head
Office site. The two sites are connected by a PPP link over a
wide area link—either a dedicated leased line or an ISDN call.

BEFORE YOU START

1   Ensure that the routers to be configured are connected to
the wide area link, and that the wide area link is operational.
See Getting Connected for information about connecting the
router to different physical networks.

2   Connect a terminal to the console port (port 0) on each
router, as described in the AR700 Series Router Quick Install
Guide. Alternatively, you can connect a PC to the console port
and use a terminal emulation program like Windows™ Terminal,
or Telnet to the routers using a Telnet client. To use Telnet both
routers must be configured for IP. See Configuring an IP Network
for details.

3   Login to the MANAGER account on each router, as
described in the AR700 Series Router Quick Install Guide.

4   Collect the information that you will need to configure IPX.
We recommend you photocopy the table below and fill in the
details. Pay particular attention to the following points:
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PPP interface is configured for dial on demand operation (see
Configuring ISDN Dial on Demand) or bandwidth on demand
operation (see Configuring ISDN Bandwidth on Demand), these
services will automatically be used by the IPX routing software.

Configure IPX Routing

1   Purge the IPX static database to clear any preexisting IPX
configuration and enable the IPX routing software on each
router, using the commands:

PURGE IPX

ENABLE IPX

2   On the Head Office router define two IPX circuits, one for
the Ethernet interface and one for the wide area link, using:

ADD IPX CIRC=1 INT=ETH0 NETW=401
ENCAP=802.3

ADD IPX CIRC=2 INT=PPP0 NETW=129

3   Repeat this procedure on the Remote Office router,
defining one IPX circuit for the Ethernet interface and one for
the wide area link, using:

ADD IPX CIRC=1 INT=ETH0 NETW=12
ENCAP=802.3

ADD IPX CIRC=2 INT=PPP0 NETW=129

4   The routers are now configured for IPX and can exchange
routes and service information.

Test the Configuration

1   Examine the route table and service table on each router,
using the commands:

SHOW IPX ROUTE

SHOW IPX SERVICE

The route table will contain paths from each Novell device
which advertises routes, for example file servers and routers.
The service table lists all the services, such as file services and
print services, that devices are advertising.

Note: The actual contents of the table varies with the number and
type of file servers present on the network, but there should be a
route from each router to the other, and all services shown as local
(i.e. via eth0) on one router, should also be visible on the other router,
via the PPP link.

2   Test that a workstation on the Remote Office LAN can
login to the file server on the Head Office LAN.

• Each network in a Novell internet, including all LANs and
WAN links, must be assigned a network number. Novell file
servers also have an internal network number. These
network numbers must be unique across the Novell
internet—no two networks or file servers may use the
same network number. All devices attached to a network
must use the same network number to refer to the
network. Check to see what numbers your file servers are
using. Many schemes exist to ensure that numbers are kept
unique, for example, using the hexadecimal representation
of the IP address or the telephone number of each location.

• All routers, file servers and workstations attached to an
Ethernet LAN must use the same Ethernet encapsulation or
frame type. The following table lists the Novell frame type
and the equivalent AR router encapsulation:

Novell Frame Type Router Encapsulation

Ethernet_802.3 802.3

Ethernet_802.2 802.2

Ethernet_II EthII

Ethernet_SNAP SNAP

You can determine the file server name, internal network
number, Ethernet frame type and Ethernet network number
used by a Novell file server, by interrogating the file server
itself. From the management console attached to the Novell file
server, at the system console prompt type the command
“config” and record the values of the fields “File server name”,
“IPX internal network number”, “Frame type” and “LAN
protocol”. You can also access the system console by running
the rconsole utility from any workstation logged in as
supervisor. For more details, contact your local Novell network
administrator or refer to the Novell documentation.

CONFIGURING IPX

The following steps are required:

1. Configure the PPP link.

2. Configure the routers for IPX.

3. Test the configuration.

Configure the PPP Link

Configure PPP interface 0 on each router to use the wide area
link. See Getting Connected for information about configuring
PPP to use a synchronous link. See Configuring ISDN for
information about configuring PPP to use an ISDN call. If the
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correct and “On demand” is set to “no”. If not, then repeat steps
1 through 3.

3   Contact your distributor or reseller for assistance.

Local Workstations Can Not Access Remote Servers

This problem can be caused by a number of different events. The
following give some of the most common:

1   Check that when the workstation is moved to the same LAN
as the file server, it is able to access the server. If not, the fault lies
with the configuration of the workstation or file server. Check
with your Novell network administrator.

2   Care must be taken with the workstation NET.CFG file.
Always specify the encapsulation (frame) as different LAN card
drivers use different default encapsulations.

3   Does the file server appear in the IPX service table of the
Remote Office router? If the server does not appear in the
table, its presence can not be advertised to the local LAN.
Check this by typing:

SHOW IPX SERVICE

Save the Configuration

Save the new dynamic configuration as a script, by entering
the command:

CREATE CONFIG=IPXCONF.SCP

TROUBLESHOOTING IPX CONFIGURATIONS

No Routes are Visible to the Remote Router

1   Check the PPP link is active, using the command:

SHOW PPP

The display should look like that shown above. The state of the
IPX control protocol (IPXCP) should be “OPENED”. If not,
then the fault lies with the connection between the two
routers, or the PPP configuration at either end of the link.

2   Check that the IPX circuits are correctly configured on each
router by repeating steps 1 through 3 above, or by typing:

SHOW IPX CIRCUIT

Check that there are two circuits, and for each circuit check
that the circuit is enabled, uses the correct interface and
encapsulation (for Ethernet interfaces), the network number is

Example output from the SHOW IPX

ROUTES command for a basic Novell

IPX network.

Example output from the SHOW IPX

SERVICES command for a basic

Novell IPX network.

Example output from the SHOW PPP

command for a basic Novell IPX

network.

IPX routes
Network   Nexthop                 Circuit      Hops   Cost      Uptime  Type
------------------------------------------------------------------------------
00000401  Local                     1 (eth0)     1       1       85973  Local
00000129  Local                     2 (ppp0)     1       1       85973  Local
00000012  00000129:0000cd000d26     2 (ppp0)     2       1       85973  RIP
------------------------------------------------------------------------------

IPX services
Name                                                                     Age
  Address                      Server type            Circuit      Hops  Defined
--------------------------------------------------------------------------------
ACCOUNTS                                                                 0
  00007500:000000000001:0451   0004:FileServer          1 (eth0)     1   SAP
ACCOUNTS                                                                 0
  00007500:000000000001:8104   0107:RConsole            1 (eth0)     1   SAP
TYPISTS                                                                  0
  00000012:0080488018d8:0451   0004:FileServer          2 (ppp0)     3   SAP
--------------------------------------------------------------------------------

Name            Enabled  ifIndex  Over                  CP           State
-----------------------------------------------------------------------------
ppp0              YES      04                           IPXCP        OPENED
                                  isdn-roho             LCP          OPENED
-----------------------------------------------------------------------------
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This should produce a display like that shown on the previous
page. The important point is that the file server must appear in
the service table on the Remote Office router and there must
be a route to the file server’s internal network number. If there
is, and it still does not work, contact your distributor or
reseller for assistance.

4   Check the route tables on both routers, using the command:

SHOW IPX ROUTE

Check for the presence of networks on the remote side of the
wide area network. If the remote network is missing from the
route table on either router, use the command:

RESET IPX

which resets the IPX routing software and forces the routers
to broadcast their routing and service tables.

CONFIGURING IPX DIAL ON DEMAND

If the PPP link uses an ISDN call and has been configured as a
dial on demand link (see Configuring ISDN Dial on Demand
earlier in this guide), then IPX can be configured for IPX dial on
demand services.

To configure IPX dial on demand, follow these steps:

1   Purge the IPX static database to clear an preexisting IPX
configuration and enable the IPX routing software on each
router, using the commands:

PURGE IPX

ENABLE IPX

2   On the Head Office router define two IPX circuits, one for
the Ethernet interface and one for the wide area link. Configure
the wide area link as a demand link and enable RIP and SAP
change broadcasts, using:

ADD IPX CIRC=1 INT=ETH0 NETW=401
ENCAP=802.3

ADD IPX CIRC=2 INT=PPP0 NETW=129
DEMAND=ON

SET IPX CIRC=2 RIPCHANGE=YES
SAPCHANGE=YES

3   Repeat this procedure on the Remote Office router,
defining one IPX circuit for the Ethernet interface and one for
the wide area link. Configure the wide area link as a demand
link and enable RIP and SAP change broadcasts, using:

ADD IPX CIRC=1 INT=ETH0 NETW=12
ENCAP=802.3

ADD IPX CIRC=2 INT=PPP0 NETW=129
DEMAND=ON

SET IPX CIRC=2 RIPCHANGE=YES
SAPCHANGE=YES

4   The routers are now configured for IPX dial on demand and
can exchange routes and service information. Save the new
dynamic configuration as a script, by entering the command:

CREATE CONFIG=IPXDOD.SCP

The link will be activated (the ISDN call will be connected)
whenever there is data waiting to be transmitted over the wide
area link, and deactivated when there has been no data
transmitted over the link for a period of time. The link will also
be activated whenever there is a change of route or service
information, to allow the exchange of RIP and SAP updates. To
improve performance, RIP and SAP filters can be configured on
the Head Office router to limit the number and size of
broadcasts which activate the ISDN call.

To configure RIP and SAP filters, follow these steps on the
Head Office router only:

1   Create a RIP filter that only allows information about route
changes to the file server’s internal network (network number
7500) to be included in RIP broadcasts:

ADD IPX RIP=0 NET=7500 ACTION=INCLUDE

2   Create a SAP filter that only allows information about the
file services provided by the file server (named ACCOUNTS)
to be included in SAP broadcasts:

ADD IPX SAP=0 SERVICE=ACCOUNTS TYPE=FILE
ACTION=INCLUDE

3   Associate the RIP and SAP filters with the IPX circuit over
the PPP link:

SET IPX CIRC=2 RIPCHANGE=YES
SAPCHANGE=YES OUTRIP=0 OUTSAP=0

4   Save the new dynamic configuration as a script, by entering
the command:

CREATE CONFIG=IPXFILT.SCP


